Earning your degree requires that you satisfy degree requirements that are in addition to completing a thesis or dissertation. Use the graduation checklist to make sure you have met them all. It is located at: http://grad pci.uta.edu/resources/pdf/Graduate_CheckList_Thesis-Dissertation.pdf.

Thesis and dissertation documents begin with a topic upon which you and your advisor agree. Once a topic is selected, your next step typically will be to conduct a literature review, write a proposal, and submit your proposal to your advisor for feedback and guidance. Some estimate that 35% of the total amount of time it takes from the start of the thesis/dissertation process to its end is spent on background research and developing your literature review. However, the time required will vary considerably with your area of study.

Thesis and dissertation documents cannot be created and finished overnight. It is a lengthy process with many steps that have to be completed in order for you to be awarded your degree. Many find it helpful to create a concrete plan or timeline for completing the work, laying out the tasks that must be completed, and intended dates of completion. Such a timeline should also help you keep track of important dates for applying for graduation, submitting documents to the Graduate School, and other matters that you must settle before you can graduate.

Enrollment Requirements While Working on Your Thesis/Dissertation: When you are ready to begin your thesis or dissertation research, you must enroll in the appropriate thesis or dissertation course. You must be in good academic standing and must continue to enroll in the appropriate thesis/dissertation course each Spring and Fall semester until your document is completed and accepted by the Graduate School. The credit hours in these courses vary from 3 to 9 hours and you should discuss with your advisor how many thesis/dissertation hours you should take each semester.

It is particularly important that you enroll in the proper number of thesis/dissertation hours in the semester that you defend your thesis or dissertation. Master’s students must register for a 6 hour thesis course in the semester they defend. Doctoral students must register for a either 3, 6, or 9 hours of dissertation depending on where they are in their PhD career. See the Graduate Catalog and your advisor for a complete description of requirements pertaining to enrollment by thesis/dissertation students.

Creating Your Thesis or Dissertation Committee: Once you have completed your proposal, you will have to “defend” it before a supervising committee. These committees consist of your supervising professor and other graduate faculty who have agreed to review your proposal and formally discuss it with you. These individuals will read your manuscript, make suggestions when appropriate, and assess your knowledge of the subject. The committee must approve your proposal before you start the work. Once you have completed your project and written it up (with guidance from your supervising professor), your committee will meet with you again in your “final” defense to discuss and evaluate your completed thesis/dissertation.

Select your committee with care as your success and the quality of your work can be materially affected by your choices. Committee members should be individuals you have studied under before, or faculty members in your department, or faculty members in a discipline related to your work. Seek the advice of your advisor when selecting your committee members.
A thesis/dissertation committee must have at least three members. See the Graduate Catalog for information on who may qualify to serve on a thesis/dissertation committee.

**Defense of Your Proposal:** Your first formal meeting with your entire committee is called the thesis/dissertation proposal defense. Defenses are conducted differently by different departments, so consult with your advisor to learn what to expect and how to prepare for it. At the end of your defense, your committee will have to decide whether to approve your proposal, enabling you to move on to develop the final thesis/dissertation, approve it with modifications, or not approve it. You must not try to complete your thesis/dissertation unless your committee has approved your proposal.

**Final Defense of Thesis/Dissertation:** When you have completed your approved thesis/dissertation and written it up, you must submit it to your committee for their evaluation and comments. Final defenses, like proposal defenses, are conducted differently by different departments, and your advisor will be able to help you prepare for it. Your committee will ask questions about your work and may make suggestions to which you may need to respond. Scheduling and holding the final defense must occur on or before certain deadlines. Please consult the Graduate Catalog for the deadline dates. Make sure you schedule your defense early enough so that you can make any revisions required by your committee and still be able to submit the final draft to the Graduate School for the mechanical check by the deadline.

**Thesis and Dissertation Format and the Role of the Graduate School Thesis and Dissertation (T&D) Specialist:** Thesis/dissertation documents must be written in the proper format in order to be accepted by the Graduate School. Format requirements ensure that all thesis/dissertation documents have a uniform appearance and are suitable for archiving. The T&D Specialist performs what are called mechanical checks of all thesis/dissertation documents which ensure that format requirements are met. The nature of these checks is described in detail below. Once the T&D Specialist has determined that your document meets Graduate School requirements, you will receive notification that your latest submission has been accepted by the Graduate School.

**Please note:** The T&D Specialist only checks the format of your thesis/dissertation and calls problems to your attention. He/she will not correct format errors, copy edit, or spell check your document. These tasks fall to you as the author responsible for the content of your thesis/dissertation.

Formatting requirements are described in detail below.

The T&D Specialist provides several services that will help you meet the format requirements of the University. They include the following:

- Seminars that walk you through the entire thesis and dissertation process. You can sign up for one by going to this link [http://grad.pci.uta.edu/students/services/workshops/](http://grad.pci.uta.edu/students/services/workshops/).
- Assistance using the UT Arlington formatting template, which enables you to format your document automatically.

Help is available at the T&D workshops and via e-mail. If you have questions or problems to resolve, contact the Graduate School T&D Specialist via email at [graduate.graduation@uta.edu](mailto:graduate.graduation@uta.edu).

**Our experience is that students who attend a seminar and use the template have relatively few problems formatting their theses/dissertations.**

**A Note on the Use of Typists:** Some students do not wish to type their thesis or dissertation or may wish to have someone else make sure that their work conforms to the format requirements of the University. These students should hire a qualified, professional typist who is familiar with UT Arlington’s formatting
Before giving your thesis or dissertation to a typist, you should contact the individual and discuss their experience, time schedule, and fees. Be sure to give the typist a clean, easy to follow draft from which to work and be certain to keep a copy of any material you give to him or her.

The Mechanical Check: The mechanical check is required for graduation. You must submit your document for mechanical check by the deadline on the Graduate School calendar. Please consult the Graduate Catalog for the deadline to submit your document for mechanical check. The copy of your thesis/dissertation submitted for mechanical check must be your complete (or very nearly complete) document. The mechanical check is used to make sure your entire work is formatted properly. Depending on the nature and number of corrections required, you may be asked to submit your document for mechanical check again, or even several times until all problems have been resolved. Use the template to format your thesis/dissertation to keep problems to a minimum. Try to submit your mechanical check as far in advance of the deadline as possible so you will have plenty of time to make corrections in the event that multiple submissions are required. Note also that you can submit your document for mechanical check before your defense.

You should submit your thesis/dissertation electronically via www.etdadmin.com/uta. Once the mechanical check has been completed, you will receive an email listing the corrections you need to make to your document. This feedback should be provided within three working days, but slightly longer delays should be expected if you submit your documents close to or on the deadline date.

Students are not required to submit any paper copies of their document to the Graduate School. The final version of their electronic document will be used for archiving.

Policies Applying to Theses and Dissertations

There are a number of policies applying to thesis/dissertations documents that you must follow as you prepare your work and ready it for archiving. These policies do not pertain to format per se, but they are rules to guide you at various stages of the thesis/dissertation process.

Name Policy: There are fixed rules governing the name that appears anywhere on your thesis/dissertation, such as on the copyright page, title page, and the abstract page.

1. Your name on the thesis/dissertation must match your name on official University of Texas at Arlington records. This means when you give your name in your thesis or dissertation, it must be the same as the name appearing on your UT Arlington transcript.

2. In order to use a different form of your name, you must file a Request for Name, I.D. Number, or Address Change form with the Graduate School. You may obtain the form from the Graduate School website at http://grad.pci.uta.edu. Approval of this request will change your name on all official University Documents, including your transcript.

3. The names of international students must appear on the thesis/dissertation in correct order according to U.S. custom. That is, the given (first) name must appear first, followed by the family (last) name.

4. Names that are truncated on UT at Arlington records because of space limitations in computer records may appear in full on the thesis or dissertation.
**Intellectual Property:** A thesis/dissertation may contain research, musical compositions, art, software, or other intellectual property that is protected from unfair use by others. You must ensure you have not violated the intellectual property rights. You must fill out and submit the UT Arlington Intellectual Property Statement Form as part of the thesis and dissertation process. You will find the form at [http://grad.pci.uta.edu/resources/pdf/Intellectual_Property_Form.pdf](http://grad.pci.uta.edu/resources/pdf/Intellectual_Property_Form.pdf).

**Plagiarism:** Students are responsible for ensuring their theses/dissertation is their original work and for respecting intellectual property of others. Students found guilty of plagiarism or other improper procedures are subject to appropriate disciplinary actions. Please see the Graduate Catalog on Academic Dishonesty for further information.

**Copyright Policy:** Copyright is a form of protection afforded the author of original published and unpublished works. For more information on copyright issues see [http://lcweb.loc.gov/copyright/](http://lcweb.loc.gov/copyright/).

Your use of copyrighted material in your thesis or dissertation is subject to the requirements of copyright law. If your use of copyrighted material extends beyond “fair use,” you must obtain permission to use this material. Students are responsible for obtaining written permission for use of unpublished materials and long quotations (usually 150 or more words) from copyrighted materials. For other questions concerning the use of secondary or primary sources, consult your advisor, the Turabian Manual of Style or the US Copyright Office website at [http://lcweb.loc.gov/copyright/](http://lcweb.loc.gov/copyright/).

Thesis/dissertation copyrights, where applicable, are held by the student author of the thesis/dissertation at UT Arlington. Further, it is the policy of the Graduate School, as stated in the Graduate Catalog, that the thesis/dissertation which is required to be submitted to the Graduate School is University property and a student may make no private agreements with employers, funding sources, or others which restrict or infringe upon University rights.

**Copyright Process:** If you choose to copyright your work, you may use the services of UMI or you may handle copyrighting yourself. UMI charges a fee and will handle all the filing on your behalf. The fee will be added to your student account if you choose to have them copyright your material for you. If you wish to file for copyright yourself, see [http://lcweb.loc.gov/copyright/](http://lcweb.loc.gov/copyright/).

Regardless of whether or not you officially copyright your work with the US Copyright Office, you may leave the copyright page in your document as your work is technically copyrighted to you since you wrote it.

**Patents:** A patent might be more effective in protecting certain inventions and procedures than a copyright. A patent is a grant of a property right by the government to the inventor “to exclude others from making, using, or selling the invention.” For more information about patents, please see [http://www.uspto.gov](http://www.uspto.gov).

If you have a patent pending or any other substantial reason you would like to delay publication of your thesis/dissertation, your supervising professor must submit a request in writing to the T&D Specialist. The maximum time a thesis/dissertation may be withheld from publication is two years.

**Thesis and Dissertation Fees:** There are fees associated with processing thesis/dissertation documents. Fees are charged to the student’s account during final processing of the document. For specific fee amounts contact the Graduate School via email at graduate.graduation@uta.edu.

**General Requirements for Preparing a Thesis/Dissertation for Submission to the Graduate School:** In preparing your thesis or dissertation, it is important to adhere to the format presented in the templates on the Graduate School website. Subheadings, spacing, capitalization, figure captions, table
captions, punctuation, indentations, margins, etc., must be properly and consistently formatted.

**Margins:** Chose a set of top, bottom, and side margins and use them throughout your thesis or dissertation. Do not change margins from section to section except as directed below. Margins set in accordance to the following guidelines are acceptable:

- All margins must be at least 1.25" and may not be more than 1.5". On some pages the bottom margin may of necessity be more than this to accommodate the requirement that subheadings be followed by at least two lines of text or be moved to the next page.

No margin may be more than 1.5" **except** for the first page of each major section in your front matter, back matter, or chapter in the body of your thesis/dissertation. Specifically, the following pages must have a 2" top margin.

- Title page
- Dedication
- Acknowledgments - the date at the end of the Acknowledgements must be the date of your defense
- Abstract
- Table of Contents
- List of Illustrations
- List of Tables
- First page (only) of any new section or list included in the front matter of a thesis/dissertation
- The first page of each chapter in the body of the thesis/dissertation
- The first page of the Bibliography or References.
- The Biographical Information

There are two other exceptions to the margin rules that apply to most of a thesis/dissertation. The following should be centered vertically and horizontally on their pages.

- Copyright
- The text on the cover pages of the appendices. The materials included in the body of an appendix should fall between the margins set for the body of your thesis/dissertation.

Examples of how these pages should be formatted can be found in the templates on the Graduate School website.

**Font:** Most conventional fonts are acceptable; novelty styles such as script, italics (except for titles), and all-capitals are not. Accent marks can be used when appropriate. Use Times New Roman or Arial as these most easily converted to PDF.

For the body of the thesis/dissertation you should normally use 10 pt. or 12 pt. font. Font up to 14 pt. may be used if the overall appearance of the thesis/dissertation is uniform and appropriate. Smaller font sizes may be used in large tables as long as the table is easily read.

**Line Spacing:** The text of the thesis/dissertation should be double-spaced.

**Paragraph Indentation:** The first word of a new paragraph should be indented one tab length. Use the tab key to ensure that they are consistent throughout your thesis/dissertation.
Quotations: Prose quotations that are three or fewer typewritten lines long should be set-off with quotation marks and typed like any other text. Quotations that are four or more typewritten lines must appear in block quote form. See the requirements below. Students in the Department of English should see their advisors concerning formatting block quotes. For all other students, block quotes must be typed as follows:

- Do not use quotation marks with block quotes.
- Single space between each line of the quote (double space between the rest of your text and the beginning and end of the block quote to set it off).
- Each line of the block quote must begin four spaces in from the left margin and end no closer than four spaces from the right margin.

See Turabian, Chapter 5 for examples of the block quote format.

Graphics and Illustrations: All illustrative material is expected to reflect the high standards of the graduate programs. Computer graphics, scanned photographs, or other like material must be clear and legible. Letters, numbers, symbols, etc., included in these materials must be legible, and font size should conform to guidelines presented earlier. Students and their committees should consult with the T&D Specialist if they have questions about how these materials should be created and reproduced in theses/dissertations. The following offers some general guidelines pertaining to creating figures, illustrations, and tables. For more details, see Turabian, Chapter 7.

- Presentation of such materials must conform to the margin specifications stated above.
- These materials may be integrated into the text or they may appear on separate pages within the text, or included in separate appendices. If figures and tables are to appear within the text, they must appear as close as possible to the text which refers to the figure/table. Figures/tables cannot simply appear all together at the end of a chapter.
- A minimum of two single lines of blank space should appear above and below these materials when they are included in the text.
- All pages containing these materials must be properly numbered.
- Figures or Tables in landscape orientation must have the title also in landscape orientation. However, the page number must remain in portrait style.

Including Large Size Documents in Your Thesis/Dissertation: Electronic submissions may include data in a supplemental file to be included with the final electronic thesis/dissertation submission. See the electronic submission website at www.etdadmin.com/uta for instructions on including supplemental files with your submission.
Additional Formatting Help

This section was added to help you with some of the unique formatting problems that thesis/dissertation students sometimes face. If you run across a fairly common formatting issue that is not listed in the main instruction manual or is not addressed here, please communicate the problem (& solution if you have it!) to graduate.graduation@uta.edu.

Footnotes and Endnotes
To insert a footnote or endnote simply place your cursor where you would like the superscript footnote reference to appear. Go to the <Insert> menu and click on <Footnote>. Choose the “footnote” option (or “endnote”) and the “auto number” option and click <OK> (for additional formatting options click <Options> before you click <OK>). The superscript number will appear in the spot where you originally placed your cursor, and the footnote at the bottom of the page is ready to be entered.

Formatting a Table from Scratch
To format a table using Microsoft Word, begin by placing your cursor in the text approximately where you would like the table to appear and hit the enter key twice to create a space for your new table. Go to the <Table> menu and choose <Insert>. Choose the number of rows and columns you would like your table to have. If you would like the cells of the table to adjust automatically according to the length of the text in each cell choose the “Autofit to Contents” option. If you would like each cell to be exactly the same size, choose the “Fixed column width” option and choose the size of the columns in the window to the right of this option. A blank table will be placed in the text near your cursor. Click within each cell to add information. You can move quickly through the table by using the Tab key.

If you need to add or delete columns or rows, place your cursor in the cell that you wish to be adjacent to the new column or row, go to the <Table> menu, select <Insert> and choose to add rows above or below the cell occupied by your cursor, or to add columns to the left or right of your cursor. To move the table to a different location, you must simply cut and paste. To delete a table, place your cursor in the table you wish to delete, go to <Table> and choose <Delete> and “Table.”

Large Tables - See the example in the template
Large tables can sometimes pose difficult formatting problems, especially if they span multiple pages. The first page of the table should be formatted just like any other table. The subsequent pages of the table should begin with the words “Table x.x – Continued” at the left margin, one line above the continued table. The word “continued” should be capitalized and italicized. Omit the quotation marks and use the number of the table in place of x.x. The rest of the table should follow. The continuation label can either be accomplished by using the <Split Table> function in MS Word or you can create a text box and place it above the continued table.

Tables in Landscape Orientation - See the example in the template
If your table is too wide to fit on a page, you may change the orientation of the page to “landscape” to accommodate your table. To do this you must first insert a new section into the template. You can do this by using the <Insert> function in the toolbar and inserting a Section Break (next page) option. You will also need to put in a Section Break at the bottom of the page so that the landscape page is its own item. Once you have created your new section, use “Normal” in <View> to see how it looks. Do not delete the Section Breaks. Switch over to the “Print” view in the <View> menu. Place your cursor on the page you wish to turn and go to <Page Set Up> in the <File> menu. Select the “Paper size” option at the top of the menu box. Select “landscape” under the orientation option and select “This section” on the “Apply to” pull down menu to the right of the menu box.

Formatting Page Numbers in Portrait Style on Landscape Pages
To create a portrait-oriented page number on a landscape-oriented page, you can use the Text Box method or the Table method as described below.
1. Open your document, and set up the different sections to accommodate the landscape page (or section). With the insertion point in the landscape section, click Header and Footer on the View menu. On the Header and Footer toolbar, click the Same as Previous button to make the header and footer for this page separate from the previous one. Repeat this procedure for the section following the landscape-formatted section. Click Close. For more information about different headers and footers, click Microsoft Word Help on the Help menu, type different headers and footers in the Office Assistant or the Answer Wizard, and then click Search to view the topics returned.

2. Position the insertion point in the landscape-oriented section, click Header and Footer on the View menu, and use either of the following methods to create the header or footer:

Text Box Method
b. Click the Margins tab, and increase the right margin to a value that gives you room for the page number (text). For example, change the right margin from the default 1 inch to 1.5 inches. Change the other margins as needed. Then click OK.
c. On the Insert menu, click Text Box.
d. Using your pointer, draw a text box in the right margin area of the landscape page. After the text box is drawn, it remains selected.
e. On the Format menu, click Text Box. On the Color and Lines tab, in the Line section, change Color to No Line, and then click OK.
f. Click in the text box. On the Text Box toolbar, click the Change Text Direction button to change the text to the direction (orientation) that you want.
g. Type the header or footer text you want into the text box. To add the page number, type the word Page, press the SPACEBAR, and on the Header and Footer toolbar, click the Page Number button.
h. Make any other formatting changes that you want. On the Header and Footer toolbar, click Close.

Table Method
b. Click the Margins tab, change the Top Margin to a negative value. For example, if your top margin is 1.25 inches, change the Top Margin value to -1.25 inches (Note the minus sign).
c. On the Table menu, click Draw Table. You now have a Tables and Borders toolbar. Using your pointer, draw a table on the right side of the header that extends down the page. Draw one large table cell that is in the expanded margin area. Then draw any additional cells by drawing lines to divide the large cell into smaller cells.
d. Click in a table cell. On the Table menu, point to Select, and then click Table.
e. On the Format menu, click Borders and Shading. On the Borders tab, under Settings, click None, and then click OK.
f. Click the cell where you want your page number to appear. Type the word Page and then press the SPACEBAR once. On the Header and Footer toolbar, click the Insert Page Number button.
g. To rotate the text, on the Tables and Borders toolbar, click the Change Text Direction button until the text is in the direction you want. Then, on the Formatting toolbar, click the Align Bottom button.
h. Make any other formatting changes you want to the table. On the Header and Footer toolbar, click Close

NOTE: A table is effected by the bottom margin of a page. It is possible for text to be cut off (cropped) if the table is drawn in the bottom margin area. To correct this problem, either resize your table so it does not flow into the bottom margin, or change the bottom margin of the page. For more information about tables, click Microsoft Word Help on the Help menu, type about tables in the Office Assistant or the Answer Wizard, and then click Search to view the topics returned.
Large Figures
If at all possible, a single figure (including its title and any legends) should fit entirely on one page. Figures larger than the normal page size may be reduced to fit. If reduction is not feasible as in the case of large maps or photographs, for example, the material may be included with the electronic submission as a Supplemental File.

Multiple-part Figures - See the example in the template
If you wish to combine two or more illustrations into one figure, both parts of the figure must fit on one page. The figure is given only one name and number, and is listed only once in the List of Figures. Each part may be assigned a letter designation.

Single Spacing Titles in LaTeX
Some students choose to use the LaTeX template for their document. The way LaTeX handles the Table of Contents and the List of Figures is that it automatically reads the section headings/subheadings/figure captions and stores them in a separate file. Hence the whole title/caption is automatically selected and it is not easy to control the layout in the final table of contents. However LaTeX provides a way to manually control it. An example of how to do this is:

```
\subsection{Influence of Nanotube Length and Diameter on the Conductivity}
```

This is an example of a long sub-section heading. To control what goes into the table of contents, LaTeX gives the option of putting whatever is desired in the table of contents, in square brackets just before the braces. For example :

```
\subsection[What is put here goes into the table of contents]{Influence of Nanotube Length and Diameter on the Conductivity}
```

So to control the layout of the table of contents, manipulations can be done in the square brackets. The following command gives the layout required by the Graduate School:

```
\subsection[protect \vspace {-2ex}{Influence of Nanotube Length and Diameter on the Conductivity}]{Influence of Nanotube Length and Diameter on the Conductivity}
```

The "\" gives a line break and the "protect \vspace {-2ex}" makes sure that the break is single spaced. A similar thing goes for the figure caption, but in the figure environment '\\' does not work. Instead 'newline' does the trick. An example is:

```
\begin{figure}
\centering
\includegraphics[width = 4.5 in, height = 3.7 in] {fig11.eps}
\caption[Variation of the effective thermal conductivity $k_\{33\}^\ast$ with nanotube length]{Variation of the effective thermal conductivity $k_\{33\}^\ast$ with nanotube length}
\end{figure}
```
In certain cases, `\hspace{-1ex}` may be required to align the separated lines horizontally like in example given here.

**Margins in LaTeX**

Some students also have trouble with the bottom page margin in LaTeX. If your margin is greater than between 1.25 and 1.5 inches, use text height 662pt.

**Template Instructions**

The UT Arlington template addresses many of the challenges of formatting a thesis or dissertation. Thesis/dissertation formatting requirements are dictated by a combination of reference sources, Kate Turabian’s *A Manual of Style for Writers of Theses and Dissertations*, this manual, the template itself, and UT Arlington tradition.

Many of the elements you will find in this template and in the accompanying instruction manual will be helpful. Please let us know what you found to be useful, missing, confusing or harmful. You may email your comments to graduate.graduation@uta.edu.

**Template Components**

- **Part S** – Sample pages that coincide with numbered instructions for systematic formatting requirements and explanations.
- **Part I** – Written instructions for using the template as well as step-by-step formatting instructions that go hand in hand with Part S.

**To begin**

Open the appropriate template and copy/paste the text into a new document on your computer or save it to a disk. Type over the template text in your new document with your own information, or, if you’ve already begun typing your document, use the template text as a guide. Do not type over the template text online.

**Views**

The template enables you to toggle between different “views” of based on the needs of the application. This is an important feature because it allows you to look at how your thesis/dissertation will appear when/if printed out (Print layout view) and to switch to a different view (Normal) when you want to cut or paste material or manipulate page and section breaks. These views can be seen and switched by going to <View> and selecting the view in which you wish to work. (Web Layout and Outline views are not used in this template.) You can switch to the alternative whenever you see fit by returning to <View> and making your selection.

- **Print layout** – displays your document as it will look when/if printed, including margins and pages. This view also provides ruler guides along the top and left side of the document to assist in setting tabs or margins. This view is useful when typing text and sizing figures and tables. Note: page breaks and section breaks do not show up when in Print layout view.

- **Normal** – displays all of the text within a document and some hidden characters, such as section breaks and page breaks. This view is useful when cutting and pasting text and sections, and for inserting or deleting page breaks and section breaks, and for formatting landscape pages.

**How to set up Chapters**

1. The template contains only a few chapters. You may first want to set the number of chapters that will be included in your thesis/dissertation to your specifications by either adding or deleting chapters. To
add a chapter go to the <View> menu and choose <Normal>. This view allows you to see how the document is divided into sections and pages. Section Breaks allow you to add text and other materials to an area of the document without effecting previous or following pages. For example, if you wish to add several more pages to Chapter 1, the first page of Chapter 2 will not be affected by overflow text because it is in a separate section. The section breaks are important to the usefulness of the template and should not be deleted in most cases.

2. Once you are in normal view, highlight an existing chapter in the template. You should highlight everything from the line just beneath the section break at the beginning of the chapter to, and including, the section break at the end of the chapter. If you wish to delete the chapter, hit the delete key. Do not copy, cut, or delete the first section break or the formatting for everything before and after the break will be lost. (Hint: The “Undo” option in the <Edit> menu is a helpful tool if you accidentally lose some formatting. If you are unable to undo such a deletion, you may choose to attempt to add your own section break by going to the <Insert> menu and choosing “Break” and selecting “Next Page”. If you are unable to correct a formatting error, you will need to reload your saved version of the original template and start again.

3. If you intend to add chapters to the template, start cutting and pasting with the fourth chapter as this will eliminate problems with pagination. Follow the instructions in #1 above, but rather than deleting the selected chapter, choose the <Copy> option from the <Edit> menu. Place your cursor after the last section break of chapter four. Once your cursor is in the right location, select <Paste> from the <Edit> menu. Your new chapter should appear. Do not forget to change the generic chapter title to reflect the proper number and name of the chapter you have just added.

4. Repeat the above steps until you have a template with the same number of chapters as your paper. You will also want to use the Copy and Paste method to set up your Table of Contents to reflect the correct number of Chapters.

Once you familiarize yourself with these sections, you will be ready to proceed with formatting your thesis or dissertation. Use Parts S and I to help you correctly format your document.